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	� 
�
��� 
��� �������� ��
 ��� ����������, ������, ��� ���
��
��
� ��� �
������� 

��� 	������������� �
� ��� ��
������ ��� !�������������� ��� 	���
��� "�#
����� 
$����
��
� �
� %�������� ��� %������&����� �
����������� '���
�������. (�������, 
����, �� �&����� �����, ��� � #���� ��� ���
� ���
�� �
� �� 
�������#
 �
���
�
 ����� 
	������� � )#����, %���
��� � 	�#��������� ���
��������� *�������� ��� #��
�. 

	� �����
 
��������
� 
�� �+� �&��: ��� �����
� �
� ��� ���
�����
��� 
������� 
���� 	������������.  

)�� ����� �&��� ��������-���
� �� �������
 ��������� ����#��
 ��� ��������� ��� 
	�������������. /���
�����, �
�&#��
� ���� 
�
������ �� 

���� ��������� ���

��� 
��
 ��� ��
�� ����

�� ��� ��� ��+���� �&���. 

)�� ��+���� �&��� ��� 
�
���� 
�
�+���
� �+� ���
�����
�&� 
������� ���� 
����� 
#���, 
��
 ���� 
��
. %�������+� 
����� ���� �
�
����� ��� �����
� ��� 	��������-
����� �
� 
���&��� ���� �
��#� ���� «��#��������» ���������+ 	�������������, ��
�-
�&�� �� 
��� �
� �
�
����� �����. 1 1� ���
�����
�� ������ 
������� ��
 ���&�� ���-
�&����� #����, �&�� ��� ����������� ���������, �
� �+������� ��
#������� ������-
�������� �����&��� �
� ������������+ ��� #������ �&�� ��� �
��������� ��������-
��� �������. 1 2� ���
�����
�� ������ 
������� ��
 ���&�� ����������+ ��� 4���
��+ 
"���&��� ������� 
������/����
������ �����#�� 
�� �+�#����� ���������&� �������. 

�����+� ��� �� �����#�����, � ����
�� ��� +��� �
� �� ��
����&� �
 �������&���� 
���� �
�
����� ��� 

����� 
�#�� ��
� ���
������ ������������� �����#�� ��� ������-
�� 
���������� ��� $��������, ���������� �
� ����

����������� "�#
����+. 1 ���-
�#��� ��� ���
� ��� �� 
�
��� �
 ����������
� ����#��, ������ �� �&�� ���
�����
�&� 

�������, �� ���#� �� ��
��
�� ����6� ��� �
� ������������ ������ ��
������ ��� 
	�������������. 

'
 ����
 �
 ��#
������� ��� ����
�� ���, �. �&��� �
���, �
������ ��� 	���
��� 
��� %�������� & 	��������� "�#
����� ��� %������&����� �
����������� '���
��-
����� ��
 ��� ����� �
� ��
����� ��� 
�����
, � ������ ���&

�� ����
����� ��� ���&#�-
�� ��� �����
����� ���������
� �
� ���� 
������ �
��� �� ��� �� �������. ��#
����� 
�� �
����
 ���, �. 9��
 !�����+�
, �
�������
 ��� 	���
��� ��� %�������� & 	���-



8 (. <
=�����: 	������������. '�������� ����&����� �
� ���
�����
�&� 
������� 
 

������ "�#
�����, �
� ��� ��������� �
� ����, ��������� )����
����, �������� �
��-
���� ��� 	���
��� "�#
����� $����
��
� �
� %�������� ��� %������&����� �
�������-
���� '���
�������, �� ������, ��

�-���
� �� 
�#��� �������, &�
�
� �
�
�������� ��� 
��������� ��� �&���. 	�� ���+�� ��
 �
 ���� ��� 
���&���� ��� 
�
��� &#�� 
���������-
�� � �����
�&
�, � ������ �
 ��
� �������� ��
 ����
������ �
�
������ � �������.  
 '
 ����
 �
 ��#
������� ����� ���� ������&� �
� ��� ��������&� ���, ��� ��������� 
��#�� ���� ��� 
�
���
=��� ���
��������� ��
����������� ���, �� ������, #��� ���� 
����
����� �������#� ���� ��
 �
���
�
 ��� 	�������������, &���
� �� &�
���
 ��
 
�� �&����� ��� 

����� ����� ��� 
�#����������� 
���+ ��� 
�
����. ������, ���� �����-
�&� �
� ��������&� ��� ��� �����
 ��
����&� !�������������� ��� 7�� ��
����� ��� 

�
���
=��+ &���� 2011-12, ��
 ��� �������������&� �
�
�������� ���� �� ����
�
 ��� 
1�� ���
�����
��� �������. 	&���, ��#
����� ��� �. )���
 "
��� ��
 ��� ����&���
 ��� 
����&���, �
� ��� �. '������ �
�
=������ ��
 �� 
�����
 ��� �#���
�� ��� ����+����. 
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������
	���
� 
1 	������������ ���
� � �������� ��� �
�
������� ��� �
����&��� �
� ��� #
�
-

����������� ��� ������ ��������
� 
�� 
����
��. D
��-��
� ���� 
���������
�� ��� +-
��� �� ��� ��������
������� 
�����
���
. 

%�� �
 ��
�������� ������ ������������� ������
�
 (�������������
��, �������-
������-����
��������, ���
������� �.�.), 
��� �� 
�
��� ������ �
 ������������� ������-
�� ������������� ������
�
, ���
�� �
 ������
�
 ��� �
�
����� ������� ��� ������ 
��������
� �
� ��� 
�������&��� ���. 
 

���	����������	
 �	�������!�-��
�� 
1 ��������
������� ��&����
 ��� ���&����
� ��� ����� ��������
�������� ����-

���, �
 ����
 ��
������
� ��� ���� �� �
#+���
 ����� (c=299.792.458m/s), �����-��
� 
��������
������� 
�����
���
 (1"%). 	
 ��������
������� �+�
�
 ���
� ���#������&�
 
��������� �
� �
������� ����
, �
 ����
 �
�
�������
� �����
 ���� �� ���+����� ���-
����� �
� �� �����
 ������
 ���
�+ ����. %�����
 �� �� ��#�����
 ��� ������� �
� ��� 
��&����
 ��� ���
�&���
�, � 1"% ��
������
� ���� �
��
���&� �����#&� (���. 1) ���  �
-
����������, ��� ������������, ���� ��������, ��
��, ���� �������� �����#� �
� ���� 

������ � �
� �. 
 

�!��	�� 1. �����#&� ��� ��������
�������+ ����
���. 
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"#���� �����������
��� �� ��� �$% 
��
����
 
)��� ������� ��� �������������� �������������� ����������, �
�
������
� �� 
��-

�&����
 ��� 
���

�
� �����
��� ��� ��������
�������� 
�����
���
� �� �
 
���������
 
��� ������ ��������
� �
� �� ��� 
�����
��
. 	
 ���� 
���� ��� 
���������
��� ���
� � 
������
�, � 
����

�, � �����
�, � 
���

�, � �����

�, � 
����!��
� �
� � ������� 
��� 
�����
���
�, �� 
���&����
 �� ���

��� ��� ���&����, ��� ���+������, ��� ������ 
�+�
���, ��� ������� �
� ��� ����� (���. 1 �
� 2). 
 

 
��	��� 1. %�����&��
�
 �+���� 
�������������� �� ��� 1"%. 

	�������� = ������, ���
�����&� = ����, �+���� = 
����+���
 ���
����
, ����
. 

 

 
��	��� 2. 1 1"%, �
��� ��
�+�� ��� 
�����
��
 (1), �����
�
� ��������, ��&�
��, �����
��, 
-
��������� �
� ������� (�
�����
 ���
������/������). F������
� ��� ����� ��������
, �
��� 
���

�����&�� (������� �� 50% ��� 
�#���� ��&����
�), ���
�����
�, 
�
����
�, ��
#&��
�, 
���-
�����
� �
� ���&����
� (�� ��������
) 
�� �
 �+��
 ��� �&����� (2). 1 ��&����
 ��� �
����+��-
�
� (3) ���� �� ������������� ���������� �+����
 �&#��
� 
�� ��� 
�����
��
 �� �&�� ���
��-
����, �+����
 �� �� ������ (1). ������, ���� ��� �������� �
����+���
� �&��� ��� 
�����
���
� 
��� �����-��
� ��� ������ (1) �/�
� 
�
����
�, ��
#&��
� �
� ���&����
� 
�� ���
 
���������
 ��� 
������ ��������
�. 1 ������
�&�� ���� 
���� ��� 
�������������� ����&���
� 
�� ��� ������-
��, � ������ ���
����� (4) ��� ����������� ���� ������� ��
��� (5). 1 �������
��
 ��� ��
��
��-
������
� ���� ���� ��� ������
��� �
 �����&6�� �� ���������
 ��� ������� �����
� (6) ��� �
�
���� 
� #������. 

 
	
 ������� ��� ���

���� ��� ��������
�������� ��&����
� ��
�����
� 
�� �� �+-

�� ��� ��������
�, �� ����� �+�
��� �
� �� ����
 ����������. <��� 
���������� &#�� ��-
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�������� �
�
���� 
�
��������, 
�������+����� � ������������ 
�����
���
� ��-
�
������ ��� ������ �+�
��� �. 1 ���&�� 
���� ��� �
��
����� ��
�����������
� �� 
������
 ���� �+�
��� ��
��
��-�� �� �������� ��� 
�������&��� ���
�+ ���� (���. 3 �
� 
4). 1 ����� ��� �
��
����� �
��+��� ��� 
�������&���, ���
������ ��� ������ �+�
��� 
�, �����-��
� �

�
���� �
��!���
 � �

�
���� �����
�� ��� 
�������&���. )����
, 
����#��� ��
�&����� 
�
�������� �
��
����� 
�
������� ��
�������� 
�������&��� 
��� ������ ��������
�. 
 

 
 

 
��	��� 3. 
. F
��
���&� �����
�&� ��
��������� ������, 
. F
��
-
���&� �����
�&� ��� ����� 
��������. �. /� �
��
���&� �����
�&� 
�+� �&����� (�.#. %1 �
� %2) ��� ����� ������ (�.#. &�
�
) ��
�&����, 
�
� � �������� ���� ���
� 
&������ ���� ��&����� �����#� ��� ����
-
���. 

 
&����� 
/� �
�������� ��� ������-��� ��� ��
���� 
��
�
��
��������
 ���
� � ���

�
, � 

���, � ��
�"���
 ��� �������, � �������������
 �� �#����� ��� 
������ �
� �� ���
����� 
��
���. 

1 ��� ��
����
� 
�� �� �&����� ��� ���
������ ��� ����&���� �� &�
���. 1 ��
#+-
���
 ������-�� �� ����
 
����
��� ��� 
�����
���
�· ��
 �
�������
, � ������� �����-
���
 ����&��� �
�������� 
����
��, ��� � ��
#��
 ��������
 �� ���#��� ��� 
�����
���-

� ���� ���� ��� �����+�����. 9�� ���
�+���� ���
� � �������������
 ��� ������� �� ��-
�
���� +��, ���� �������
� � 
����
�� ��� 
�����
���
� (���� 
����������). %������
, 
� �
�����
 �������� ��� ������� 
������� ��� 
����
�� ���� ��
�� ������� (RED) �
� 
��� �������� ���� ���+� ��&����� (NIR) �����#� ��� ����
���. 

1 �
�����
 ���
��
� ��� &�
��� ������� ��� 
��
�
��
��������� ���. 1 ��� ��� 
������� ���
� ����
 ���#�����&�� �� ��� �����#����� ���
��
 �� 
���· ��
 �
������-
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�
, �� #���������� &�
��� �
�
������
� �6��� ��
�����
 
������������ �
�, �
�’ ��&-
��
��, ������ 
����
��, ��� ��� ���������� &�
��� �6��� ���������� ���
��
� �
� 
����� 
����
��. 

/� �
�
�������� ��� 
�
��
��������
� ���
� ����������� ���� ��&����� �����#� ��� 
����
���, ���� ��� �&������ 
���������� ��� ��&����
� 
�� �� ���� (���. 3.
). !�����-
���
, � ������������� ��� ��
����� ��� ��
��������� ���
��
� ������#����
� �+����
 
�� 
��������� ���� ��
�� �����#� ��� ����
���. !�’ 
��� #����������+��
� 
��������� 
�
� ������� (� ���. 73, 75, ������� SR, NDVI, LST, �.�.) ��� NIR �
� ��� ������� ��&����� 
(LWIR � TIR) �����#� ��� ����
���, ��
 �� �������� ��� ��
��������� ����� ��� ���-
���� �
� ��� ������������ ��� ��
��������� ���
��
�, � ����
 ����+���� &����
 
�� 
�� ��
���� ��� ��
��������� �������
��
�. 	&���, &������ &#��� ������ ��� � ��
����-
���� ���
��
 �������-��
� 
&�����
 ��� ��#�����
 C-Band (�&�
 
�� �� #���� ��� �����-
����&��� ��#�����
� �� ��
����&� ��� ���
��
 �
� ����� ������) �
� ��
 ����
 ���-
������� 10�-20�, �
�� ��� ���-����
 
������� �
� ������� ��� 
�����
���
� 
�� �� �+-
����
 Radar. 
 

 
��	��� 4. F
��
���&� �
��+��� ��
��������� ������ ��� ������ ��������
�. 

 
%
��	�� �'��� 
	� 
����� ���������
 ��
��������
� 
�� �� ������
�&�� ��� 
�����
������ �+�
�-

���, ��� ������� ������ ��� �
�
������, ��� 
�#����������� ��� ����� �
� ��� ����
��-
��� �������� ��� �����
��+�. 1 �������
��
 ��� ����� ���
� �
�� ������+� 

���+� 
(1-2�C ��� ��&�
, 6-8�C �� �+#�
) ���
�+���� 
�� 
���� ��� ����������, �� 
������ ��-
���#��. 	� �
������� 
��� �����-��
� 

���� ������� ��
��
, �
� �� �+���� 
����� ����-
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����� ��� ������
��
� ���� ������� ������&� ��������� (�����#����������
g � ��
�����
 
��� ������ �
 
������+��� ��������
, ������� 
���������
g � ������ �� ��� ����� 
&�
 ����� ���
�&��� ��������
) ��� 
������ �
�
������, ��� ������ &��
�� �
� ���� 

����� ��������
 ��� �����, ���� 
����&�� 
��������� �
� ���� ������ 
����
�� 
�/�
� ������� ��� 
�����
���
� 
�� ��� ������� �����&� ��� �������, ���� �
#+�
�� 
-
����������� ��� ������, ���� ��
#+���
 ��� ������, ���� 
���������� ����������� 
��������
 �.
. 1 ��
���� ��� �������
��
� ���
�+ 
�����+ �
� �� 
�����+ #���� ���-
��-��
� ���

� ��� 

����� �������� ��
��
�. !�
 ��� ������������ ��� ����
���
��� 
�������
��
� ��� ������ (�
� �#� ����, ���� �
����������� ���� ������+���� §), 
#����������+��
� 
��������� ������ ���� LWIR (� TIR) �����#� ��� ����
��� �
� ���-
����, ����, ��
 �
�������
, � ����
���
�� �������
��
 (	s, ���. 74). 

O��� ��� 
���������� ��� 
�����
���
� 
�� �
 ����
 ��� 
����� ��� 
�����
��
�, 
#����������+��
� ���� 	������������ �����#&� ��� ��������
�������+ ����
��� (
-
�����
����� �
�����
), ���� ������ � ����������� ��
��&����� 
���

���<  ��� 
�����
���
� 

���
� ���+ ������. )��� ��������� ����������+ ��� 
�����
������ �+�
���� �� �� #��-
�� ����������� �������, � ����������� ��
��&����� ����

���< ,  ��
���
� ��� ����
��� ��&-

�
���, �
�
���� ������� ���&�, 
���� �
� ���� ��������� �� ���
��&��� 
�����
��
�. 
)������, 
���&��� � �
�
������ ��� ����� ���

���� ��� ����������� ��
��&����� 
��� ���
����
��� 
���������� 
���

���<  �
� ��&�
��� ����
���< , ��
 ��� �������� ��� 
���-

��
������ �+�
����. 1 �������� �������� ��� ������� (
���&����
 
����������) �
� 
��� ���������� (
���&����
 ��&�
��� ��� ���
������) ��� �����
� �����&��� ��� ���-
������� ��� ���������
��� ��� �+� ����������� ��
��&�����, 
�� ��� ��������
 ��� 
!�� (h=0) &�� �� +6�� (h=H) ��� ���������, ��
 &�
 ���������&�� ����� �+�
��� (������ 
��#�� 
����+�
��� �� , � (������, ���. 74). 

 
(��
��
� 
)��� ��
�� �����#� ��� 
�����
���
�, � �&����� 
��������� ��� ��&����
� 
�� �� 

#�����+��� �
�
������
� ���� �����#� 
�� 0.45 &�� 0.64�m (��
�� ����-BLUE �
� 
RED). !�’ 
���� ��� ���� � �������� 
�&��� ��� ���� 
������� ������� (
��������� 

�� �
 �+��
 ��� ���� �
� �������� ��&����
� �
� 
����
�� ��� ��������, ���. 5). �����-
��� �
�������� ��� ���
� �
������ �
�� ��� 
������� ��� ����+, ���� � &����6� ���
-
��
� ��� &�
���, �������� ��� �
�
���� #�����+����, �� 
���&����
 ��� �������� 
��� 
���������� ��� ���� �
� �������� ��&����
�, ��� 
+���� ��� 
����
��� �
� ��� �-
�
��&���� ��� ����+. )�#��, � ������� 
����
�� ����� ������� #���
 ��� ����, ��� ��-
�
� � �����
���� ��� �������� �
� ��� �������� #���
���. 	� ���� 
���
�� �
������� 
�
�
������
� �
�� ��� ����
���-���
��� ��� ����+, ���� ���� ��� ������������ ��&��-
��� ��� (�
���������� �+����). %������
, � 
+���� ��� ��
��������� ���
��
� ����&��� 
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������� 
������� ��� ����+, #��� ���� �
�
���� ������������ #�����+���� �
� ���� 

��������� ������������ ��&����
� ��
 ��� ��
��
�������� ��� �����+������. 1 
-
����
�� �������
�, ������, ���� �����#&� 1.4, 1.9 �
� 2.6�m ��� ����
��� ���� ��� ��-
����� 
���������� ��� 
�����
���
� 
�� ��� ���
��
 ��� �+���� (���. 3
). !��������
, 
� 
����
�� ��� �+���� ���
� ��������� ��� ���
��
� �
� ��� ���������� ����.  

 

 
��	��� 5. / �#��
������ ��� #�������. 

 
)������, ������� � �&����� ��
���&� ��� 
�
��
��������
� ��� ����� ��� ���
� 
��-

������ �����+� �
 ������������+� ���� ��
�� �����#� ��� ����
��� �
� ���� �����#&� 
�+�� 
�� �
 ���� �+�
��� 1.4, 1.9 �
� 2.6�m. "���&�, ����, ��
���&� ���
� �+����� �
 
������������+� ���� 
�������#�� �&����, ��
���
� 
���
�� ��� ������� 
���������� ��� 

�����
���
�. /� �
�
���������� -���� ��
 ��� ������������ 
���� ��� ������ ��
��-
��� ���
� �� �����#&� ������� 
����
���, ���� � �����#� 
�� 0.7 &�� 1.1�m ��� ��-
��
��� (NIR, ���. 3
,�) �
� � �����#� 
�� 1.5 &�� 1.8�m (
�
#��
 ��&�����-SWIR). )� 
�-
��� ��� ���������, �����+� �#� ���� �
 ��
#������+� �
 ���� ��� 
�������� ���
�+ 
���� (���. 3
), �
 ����
 ���
� ���
�� �
 &#��� �� ���� #���
 ��� ��
�� ����
, 
��� �
 
������������+� �
� �� ����&� ��
���&� ���� �������
 ��� ����� ������ (���. 3�). 	&���, 
&������ &#��� ������ ��� � ���&�� ��� 
�������� ������ �
 ��
��
��������� ��� ��#��-
���
 L-Band (���
�+���� ��������� ��� ��������� ��� ����+ �� �#&�� �� ��� C-Band) �
� 
��
 ����
 ���������� >23�, �
�� ��� ���-����
 
������� �
� ������� ��� 
�����
���
� 

�� �� �+����
 Radar. 
 
 

� �)���)� ��� ��	��������	'� ��������	'� 
�
������� 
!�
 ����� ����, ��
�������� � ���6� ��� #����� ���
+��� �� ��
�����
� ��
 ��� 

�������� ������
����� ��#
��� 
�� ��� Rahrmann �� 1891. /� ������ ��6��� ����-
��
���� 
�� ����� �+�
���, �� +6�� ������� 100m, ��
��
���������
� �� 1897 
�� 
��� Alfred Nobel. 	� 1904, � Alfred Maul’s �
�
���+
�� &�
� ����� �+�
��� �
� ��
��
-
�������� ��6��� 
�� +6�� 600m. "� ��� ��������� ��� ���
+��� V-2, �� 1946, (����
-
����� ���&������) 
�� ��� ���
�� ��� 1.�.%., 
��������
� �� ������ ������� ������� 
��� ��������
� ��� !�� (�����#&� ��� w&� "����� ) 
�� �� �������
. 

1 ��
������� �
�
������ ��� ��������
� ��� !�� �������� �� ��� �
�
����� ��� 
������ ��������� SPUTNIK-1 (����� �.).).(.) ���� 4 /���
���� ��� 1957. �
������
, 
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���������� ������� ���� ��#������
 ��� �����
��
����� 
��������� �
� 
������
-
��������� side-looking radar. 1 ����� ������
��
 ��� !�� 
�� �� �������
 ������� 
��� %+������ ��� 1959 
�� ��� �������� Explorer-6 (1.�.%.). 	� 1960, �������������� 
�� ���
������� �
�
���������� �����
��
 CORONA 
�� ��� 1.�.%., ��� ��#� �� 
���&-
����
 ��� ��������� 100 ��������� 
�� �� 1960 &�� �� 1972 �
� �� ��6� 800,000 
-
�����
���� ������� #������ 
������� 2m. 

	� 1961, ������
� ������
���� 
�� �� �����
����������� ��
������� ������ «�$-
4» �
�, ��� ���&#��
, 
�� �
 ����� «�$-8» �
� «�$-9». 	� 1965, ��
��
���������� � 
����� ��
�����&�� ����� «Gemini GT-3», ��
 �� ��6� &�#����� ������
���� ��� ���-
�����
� ��� !��. 	� 1967, �������
� �� ���#�
�&� ������� �� ��� ��
�����&��� 
������&� 
«Apollo» (Apollo-6, 7), �
�
������
� ��� #���� ��� �����
��
����+ 
�������
 SO65, 
���� 
������� Apollo-9, �� 1968. 

%�� ���� ��
�������� ���������� ��� ���������
� 
�� �� 1968 &�� �
� 
����
, 
���� �
�
������� ��� 
�������+�, �
 �
�����
���� � ��&���� ��� �������������� ��-
��������� ���������� �6���� #������ 
�������. 

1 ������
���� ������� ������� ������ �� ��� ��������� 
�� �� w%S% (1.�.%.) ��� 
��������� LANDSAT-1, ���� 23 *������ ��� 1972. / �����
��
����� 
�������
� (Multi-
spectral, MS, � ���. 48) ���

�� ������� ��� ��������
� ��� !�� �� #����� 
������ (� 
���. 53) 80m. "&#�� �����
, &#��� ���������� ����� �&������ ���������, � LANDSAT-2 
(22/1/1975), � LANDSAT-3 (5/3/1978), � LANDSAT-4 (16/7/1982), � LANDSAT-5 (1/3/1984), 
��� ���� ��� 
����#��&�� ��������� ��� LANDSAT-6, ��� %������ ��� 1999, �&���� �� 
���#�� � LANDSAT-7. /� 
��������� ��� 
��������� 
���+ ��� ����������+ ������
��� 
������
� ��� ��6� ������� �� #����� 
������ 30m ��
 ��� �����
��
���� �
� 15m ��
 
��� �
�#���
���� 
�������
 (Panchromatic, PAN, � ���. 47). / �&�� ��������� 
LANDSAT-8 ������+���� ��� F�
������� ��� 2013, ������
� �����
 ������� �� #����� 

������ 15m ���� PAN, �
� 30m, 100m ���� MS 
�������
. 

	� 1978, ���������� 
�� ��� 1.�.%. � ������ ��������� Radar (�+����
 Synthetic 
Aperture Radar - SAR) �� ��� ����
��
 SEASAT �
� #����� 
������ 25m. /� ����
�
��-
���� ����#�����
� �� ��� �������� SIR-A ��� (��&�
��� ��� 1981, ��� SIR-B ��� /���-

��� ��� 1984 �
� �� �+� ���������� ��� ������ SIR-C/X-SAR ��� *�+��� �
� ��� )���&�-

��� ��� 1994, 
���-���
� �� #����� 
������ ��� 10m. 

	� 1977, � !
����� <�
&����� ��&����� �� �����
��
 SPOT (Systeme Pour l' Obser-
vation de la Terre), �� 
���&����
 ��� ��������� ��� ������ ��������� SPOT-1 ���� 22 
F�
���
���� 1986. "&#�� �����
, &#��� ����� �� ���������
 ����� �&������ ���������, 
�� SPO%-2 (1990), SPOT-3 (1993), SPOT-4 (1998) �
� SPOT-5 (2002). /� 6���
�&� ������� 
��� ������
��� ��������� ��� ������ &#��� #����� 
������ 10m ���� �����
��
���� 
�
� 5m ���� �
�#���
���� 
�������
. 
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 	� 1981, �� ��������� ��� ������ COSMOS �
� SPIN-2 (����� �.).).(.) ����������
� 
�� �+� �&
 ������ ������
�
, �� ��#
�� KVR-1000 �6���� #������ 
������� 
�� 2 &�� 
3m �
� �� ��#
�� TK-350, �� ���
�����
 �������������� �
�
������� �
� #����� 
��-
���� 10m. 	
 �+� ������
�
 #����������+�
� �
�#���
���� ����. 
 )��� 17 "
����� ��� 1988, ���������� � ������ ������� ��������� �� ��� ����
��
 
IRS-1A. %����+����, �� 1991, o ��������� IRS-1B, � 
����#��&�� ���������
 
���
��-
��
��� ��� ���#�
��� �����
� ��� ��������� IRS-1E, �� 1993, �
� �� �����#��&��� ���-
�������� �������� ����������� ����������, ��� IRS-P2 (1994), ��� IRS-C1 (1995), ��� 
IRS-D1 (1997) �
� ��� IRS-P6 (2003). "� ��� �������� ��� ��������� IRS-P5 ���� 5 "
|-
�� ��� 2005, ��� Cartosat-2 ���� 10 *
���
���� 2007 �
� ��� Resourcesat-2 ���� 20 %���-
���� ��� 2011, �����
, �
�
�����
� 6���
�&� �
�#���
���&� ������� #������ 
������� 
2.5, 1 �
� 5.8m, 
�������#
. / ��������� RISAT-2 (�-SAR 2m) �&���� �� ���������
 ���� 20 
%������� ��� 2009. 
 1 
������� ��� ������� ���������� Radar �������, �� 1991, ���� �
�
����� ��� 
����������+ ������
��� ALMAZ-1. 	� 1998, � J���
 �������� ��� ��+���� �������� 
ALMAZ-1B (SAR 5m, PAN 2.5m, MS 4m). 
 )#���� �
���#���
 �� ��� ALMAZ-1, � �����
=�� (�
������� I������
 ������+�� ��� 
ERS-1 (25/7/1991). ��� � �+���� ���#�� ��� (�
�������+ ��������
��� ��
� �� ���
��-
��
���&� ��
����&�, ���+ ������
 
���
�+����� ��� � 
�������
� SAR AMI �����+�� 
�
 #������������� �
� ��
 #
�����
����+� �����+�. %����+���
� �� ��������� ERS-2 
�� 1995 �
� ENVISAT-1 �� 2002.  
 	�� )���&�
��� ��� 1992, � *
����
 #������������ �+����
 Radar ���� �������� 
JERS-1. To 1996, ��������� ��� �������� ADEOS (PAN 8m, MS 16m). 
 1 <
�
���� (�
������� I������
, �� ������
��
 �� �� NASA (1.�.%.), �� 1995, ����-
���� ��� �������� RADARSAT-1 (SAR 8-100m). )��� 14 (����
���� ��� 2007, �&���� �� 
���������
 �� ���������� �+����
 RADARSAT-2 (SAR  3m). 
 To 1999, � !���
��
 �����&���� ��� ������ ��
������� ������ «PRIRODA-MIR» ��� 

�������
� ��� �� ���#�� ��� 
�������
 MOMS-02 (PAN 6m, MS 18m). 
 1 ������
��
 ��� <��
� �� �� D�
-���
 �
�&����, ��� /���
��� ��� 1999, ���� ����-
���� ��� ��������� CBERS-1, � ������ &�
6� �
 ���������� �+� ����� ���� ��� 
���
-
����
�� ��� ���#�
��� �����
� ���. 	�� /���
��� ��� 2003, ���������� � ��������� 
CBERS-2 (PAN �
� MS 20m). 
 1 ��������� ��� ��������� IKONOS-1 ��
��
���������� �� �����#�
 ���� 27 %�����-
�� 1999 (1.�.%.)· ������, ���� ��#����� 
��
�� ��� �&���� �� �
������� ���#�� �
� #�-
���� ��� �������
. )��� 24 )�����
���� ��� 1999, ���������� � ��������� IKONOS-2 
(PAN 1m, MS 4m) �� 
�


�����&�
 ��#���� #
�
����������. 
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)
������ %�

�
, &����� Wadi As-Sirhan. )��� ������� ��� LANDSAT, 
�� �� 1986 �
� �� 2004, 
��-
�
�+����
� � ������
���� ���
����� ��� ������ Wadi As-Sirhan �� �
����������� &��
��. !�
 ��� 
������� 
�������+��
� ������
 +�
�
 20,000 ���� (URL3). 
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   LANDSAT-5 (30m)                 QUICKBIRD-2 (0.6m) 

 

 
"��&����� ��
 2x2 pixel ��� LANDSAT-5 

 

 

 
"��&����� ��
 8x8 pixel ��� LANDSAT-5 

��	��� 21�. )+������ #������ 
������� �+� ����������� ����������, ���� ���
 �����
���� 
�����#� ���&���. 

 

 

 

 

 

 

 

��	��� 22. %����
��
 ��� ����������� ����-

�
� QUICKBIRD-2. �
�
����+�� �
 ����
��-

�#���
 ��� ������� ��+�
���. 
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 1� ����
�����	
 �
	�
�:  
 �������
� ����� 	�� ���
�����
��� ��

��� 

��
����
 
1 ���&�� ����&����� #���� ��� �������+ $ ���
����� �� ���������
 ��
#������� #�-

����� �����&��� ��
 ��� ������� 1980 �
� 2000. 1 ��������� ����
�
 
�
����� ��� 
���=����� ���
� 1:5,000. ������, ����� ��� �����, �
�
���&�� �
 ���
� �
� �� #������ ��
 
�� &��� 2000. 
 

%������	� �������� 
1 &����
 ������
��������+ �����+ ������� ���� ��������� �����
 (12) 
�������-

��
���� ��� 1982 ����
�
� 1:7,000, �� ������ �
�+����� �
������ ��� ������� $. 
 

 
 
 1 �������
 ��� 
���������
���� #
�
�����-��
� �&���
, ������� ��� ���
����� ��� 
6���
�� 
������� ��� ������������ #
�
����������� ���� (� ���. 39). 
 !�
 �� ��6� ��� 
���������
���� ��� 1982 ��� �������+ $, #�������������� �
�-
#���
���� �
������
. ������, ���
� ������ �� ������������� 

���������� ��� ����-
�����
�. 
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'
 ����
 �
 ��#
������� ��� «Geosystems 
Hellas A.E.», ��
���&
 ���=����� �
� �������-
��� �+���� Erdas ��� «Intergraph» ���� ����-
�
 �
� ���� <+���, �
� ��� «Intergraph» ��
 
��� ����
 #����� ��� Print Screens ��� Erdas 
LPS ���� 
������� 
���+ ��� 
�
����. 

 

   
 

 
��
����
 ��� �������������'� 
�� Erdas 

 "� ��� ������������ ��� ���������+ Erdas Imagine 2011, ���� ����� ��
���, ���
-
��-��
� � ������ ��� ��������
��� �
� �� ����
 ��� 
�#���� (���� ��������� ���� ��� 
&#�� ������������� &�
 �
������� 
�#���, 
�
������
� Untitled: 1). 
 %������� ��� ���
� ��
����, ���
��-���
� �� ������� ������� �� �����&� Open, Save, 
Undo, Select, Zoom In, Zoom out, Clear View, �
��� �
� � ������� Customization. 
 )�� 	��!�� ����#, 
���
�� 
�� ����, �����
�
�����
� �� �
��&���: File, Home, 
Manage Data, Raster, Vector, Terrain, Toolbox �
� Help. 
 )��� �����#� ���� 
�� �� ����+, ���
��-���
� ����&���� ������&�, ��� �
 
�
��-
��+� �� �������� �
�
�������. %�������, ��� Contents, ���
��-���
� �
 
�#��
 ��� &-
#��� ���
#��� ��� ���������, ���, ��� �&���� (2D View #1), � ��������
 ���
��
� �� ��� 
������� ���� �������
��
. 

 

 
 
 )��� �
��&�
 File ��� 	��!�� ����#, ����#��� ������&� ���
����� ���� �&�� �
�
-
�+��� ���
��
� (2D � 3D), �����&���, ���� �����#&� ����
�&������ (AOI), 6������&� 
������� (Raster), ��
����
���&� ������� (Vector), ������&� �#���
���+ ��� ������� (Anno-
tation), ����&�
 (Terra Model), ������� �� ����� �+������ ���
��&� (Three Layer Arrange-
ment), ��
����&� ��� ��
����+�� (Web Service), ����������� (ECWPURL) �
� 
��������� 
(Algorithm). ������, 
�� ��� ���
 �
��&�
 �����+� �
 
������� �����
�
 �������
��&-
�
 
�#��
, �
 
���������+� 
�#��
, �
 ��������+� 
�����&��
�
/���=���
, �
 ���-

����+� �����&�
 (�.#. ������
, ������� �.�.) �
� �
 �
�����
���+� �� #���������� ���-
��/����
 ���� �� �
�
����
��&��� ����������� ��� ���������+. 
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    ������, �����&���
� � �������
��
 ����
-
���� �����&��� �
� 
�#���� �� �����&�, � 
�+����� ��� ���������+ �+����
 �� ��� ���-
����� ���
��
 �
�, �&���, � ����
������ ��� 
���������
� ��� ��������
���. 

 
 /� 
���������
���� �����+� �
 ���
#��+� ��� �+����
, ���� ����
�
������&���, 
���� ��
� �� ������ ��� ��6��, ���� ��#
�
. �����#� ��&��� �
 ����� �
�� �� �������
 
��� 
���
����
��� ��� ���������+ ����
�
�������+, ���� ��&��� �
 �������� ����� � 
����
�
�������� ��� ������
��� ��� ������������
��&��� ��� ������
����+ ����&-
��� (� ���. 90).  
 !�
 ��� ���
���� ��� 
���������
����, ����&���
� 
�� �� ������ ����+ > File > 
Open . )�� ���&#��
, ���
��-��
� �� �
������ Select Layer To Add, ��� ����� ������-
���-��
� � �&�� �
� � �+��� ��� 
�#���� ���
�����. 
 

 
 
 
 
 
 
 
      "��
�+ ��� ������� ��
������-
��� �+��� 
�#���� ��� �����+� �
 
���
#��+�, �� �������&������ ���
�: 
IMAGINE image (*.img), TIFF, JPEG 
2000 �
� JFIF. 
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�������
 DSM, DTM 
 /����	�
!� �������
� DSM, DTM 
 "� ������� DTM Extraction  ��� ��
�	
� �����
� ������!��, 
 

 
 
���
��-��
� ��  �
������ Start DTM Extraction. 
 

 
  
    "� ��� ������� Classic ATE �
� 6", ���
��-��
� �� �
-
������ DTM Extraction, ��� ����� � #������ ������ �
 
�������� ��� �
�
�&����� �
�
����� ��� DSM � DTM. 
 

 
)�� Output Type, ����&��-
�
� � ����� ��� 
�#���� 
��� �������
� �
 ����-
��������: 

ç DEM (Digital Elevation 
Model) ��
 �� ���������
 
���� 
�#���� raster, �� 
����� 
�������-�� �� 
��-
����� �� ��
��������+� 
������ ��� ����. 	� ���+-
�� ���� 
�������#�� �� ��-
���
 #
����+ �6��&����, 
��� �� 
���#�� ���� �� ��-

���
 ���
�+����� �6��&����. 	
 �����
 ���
� ���������&�
 �� ����

� �
� �� 
�#��� 
������ 
������+��
� �� ��� ��&��
�� *.img, ������������ 
�� &�
 
�#��� *.wcs. 

ç TerraModel TIN (Triangulated Irregular Network), ���� �
�����
� &�
 �+���� �����-
���, 
�
�������� ���&���� �
� �#��
���. 	� 
�#��� ������ 
������+��
� �� ��� ��&-
��
�� *.pro �
� ������+��
� 
�� &�
 
�#��� *.wcs. 

ç 3D Shape, ���� �
�����
� &�
 ASCII 3D 
�#��� ������
��&��� (X, Y, Z). 	� 
�#��� 
��� 
������ �
 #������������� �
� 
�� ���
 ���������, ���� ArcView, ArcInfo, Stereo Analyst 
(������������� �������� ��� DSM ��� LPS �/�
� ������������� 
������) �.�.. 	� �
-
�
������ 
�#��� &#�� �
������ *.shp �
� ������+��
� 
�� &�
  
�#��� *.wcs. 
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%	�!���� ��� ��)���������� ��	���� 
1 �
�������� �����������
�, ��
� ��������� � 
���
��� ���.  	
 �����
�
 ��� �
��-

�������, �
 ����
 �����-��� ��� �
�
#����� 6������ �� �
��
��&��� ������, �
����-
-��� �� ������� �����#�
� ��� �
���������. (����
���������, �� ��������� ����&��� 
�� 
���� ���� &�
� 
����� ������� ��&�#��/
����������, � ������ �
����-��
� 
�� ��� #��-
���. )�� ���&#��
, �
 ��&��� #���������
, &�
 ���� &�
 ���� ������, �
 ����#��� ��
 �� 
� 
��
��
���� 
����� ���� ����, ���� ����
 
����
�������&�
 �
�
#��������. 

%�#���, �������
� ���� ��������
 ���
��
� � ���������� �����
 (�.#. 
crop_ortho_qb_2.img). )�� ���&#��
, 
�� �� 	��!�� ����# ����&���
� Raster > Super-
vised > Accuracy Assessment. 

 

 

 
 
 
 
 

)�� �&� �
������ Accu-
racy Assessment, ����&���
� 
File > Open ��
 ��� ���
���� 
��� �
�������&��� �����
� 
(�.#. classified _fuzzy.img). 
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 2� ����
�����	
 �
	�
�:  
 �������
 DTM ��� ��������	�� ��	���� 

��
����
 
"�
 ���&�� ���
����� ��� �
�
���� DTM ��� 
������ �
� ����
������ �����#�� 4.  

)��������&�
, �
 �
�
���&
 �
 ���
� DTM �� ����

� ������� 10x10m, ���-�������
��-
��� �
� �6��������� 
���
��
� 1.5m �
� 3.0m, 
�������#
. 
 

7����	� �������� 
)�� ���&�� �
 #������������� PAN ������-�+��� (WV2_1 �
� WV2_2) ����������� ��-

����� WORLDVIEW-2, #������ 
������� 60cm. ���&��6
� 
�� ��������-�������� �
� 
������-�������� �
�� ��� ���
 ���#�
�� ��
�����. ������, � ����� ��� ������
��� �
-
�&#�� ��
 �
 
�#��
 ��� ���#�
��+ ����&��� ��� �&���, �
��� �
� �
 ��
��
���� �����-
���
. 
 

 
%����
��
 ��� ����������� �����
� WORLDVIEW-2 ���� �����#� ���&��� 4. 

 
	&���, ��������
� ($I�, �!)%87) ��� ����� 12 �����
, �� ��� ������ 9 �
 #������-

������+� �� ������
���� �
� 3 �� �����
 ��&�#��. 
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�		!��
� ��� LPS 
/� ���������&� ������� ��������
� ��� Erdas, 
���������
� ��� ��
���
���� ��� ��-

��������
� ���� ��������� ��� ������
��������� �������
��
� ��� 
���������
-
����. ������, �� ���� ����� ���-��
� �� �+����
 
�
����� ��� ������
��&��� (� ���. 
95-101). 

)�� ���&#��
, �
 �
�����
���� � �������
��
 ��� ������-�+���� ��� ����������� 
������� WORLDVIEW-2 ��� LPS. �������
� ��
 ��
 ��
���
��
 �
�����
 �� 
���� ��� ��-
����
��������� �������
��
� ��� 
���������
���� ��� 1�� ���
�����
��� �������. 

"� ��� &�
��� ��� LPS, � ����� 
��������
� 
�� �� �����
 �!����, �� ��
�	� ����#, 
�� ��
�	
 �����
 ������!��, ���� ����
 ���
��-���
� �� ����� �� ��
���
���� ��� 
��
��
������+��
� �
�� ��� �������
��
 ��� ����������� �������, �� ���	
 ������
 
1, ���� ����
 �
 ���
�����+� �� ���������&� ������� �� �������6�, �
 ������
����, 
�
 �����
 ��&�#�� �
� �+������. 	&���, ���� �	�!8� ������
 2 ���
��-���
� �� ����
 �
 
6���
�� 
�#��
 ��� ����������� ������� ���� ��� ���
���� ���� �
� �
 �����
 ��� ��-

���
���� ��� ������������
� (�.#. ����������, �
�
���� DTM �.�.�.). 

 

 
 

1 ��
���
��
 ������ 
�� �� ��
�	� ����# > File > New ��
 �� ���������
 �
� ��� 
��-
������� ��� 
�#���� (�.#. Stereo_WV2.blk) ��� ��������� ��� ����&��� ��� ��������-
��� �������. 
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 )�� �
������ Model Setup ��� ���
��-��
�, 
����&���
�  
�� �� ��������� ����+ ��� ������ 
Geometric Model Category �� ���������� ����&�� 
��� ����� ��� ������� ��� �
 #�������������. 
      ����� 
�� ��� Camera (������
���� ��#
��, 
��� 
�
�+���� ���� ��������� 1� ���
�����
�� 
������, � ���. 103), ������&#���
� �
 ��
��
���� 
��������
, Rational Functions, �� �
 ����
 �&�� 
��� ����������� RPC (� ���. 56) ���
� ������� 

���� � ����������, ��� �
� ���������� ����
�
�������� ��� ����������� �������. 
������, ����#��� ���#�
�� ����&�
, Orbital Pushbroom, ��� 
�������+��
�, ��
� �
-

�&#���
� �
������
 
�#��
 
�� ���� ������ ��� ����������. 
/� ���������&��� ������� WORDVIEW-2 ������+���
� 
�� ����� ���#�
�� �����&�
, 

��������
�

���&��� �
� ��� RPC. 9���, �� ����&� ����������� ������
� ���� �� RPC 

�� ������ 
����� �������������� ����������� ����������. !�
 ���
��������+� ��-
����, �
 ��
��
��������+� �"� �"
���, � 1� �� #���� ��
��
����� ������+���, ���-
��� ���������� ���� RPC �� ���
���� �����&�
, �
� � 2� �� #���� 
�
������� ���#�
-
��� �����&���. 
 

 
 
 
 
)��� 1� �+��, ����&���
� 
�� �� ��������� ��-

��+ ��� ������ Geometric Model Category > Ra-
tional Functions �
� ��� ����� Geometric Model > 
WorldView RPC. 

 
       
 
 
 

      )�� 2� �+��, ����&���
� 
�� �� ��������� ����+ 
��� ������ Geometric Model Category > Orbital 
Pushbroom �
� ��� ����� Geometric Model > 
QuickBird/WorldView. 
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"� 6" (�
� ���� �"� �"
���), ���
��-��
� �� �
������ Block Property Setup, ��� �-
���� �
 ������+� �
 ���
����� #
�
���������� ��� �������. )��������&�
, ���� ������-
���
 Horizontal ����&���
� Set �
�, ���� ����� �
��&�
 Standard, ����&���
� GREECE. )�� 
��"���� �
��&�
 Custom, ����&���
� 
�� �� ����+ �+����� Projection Type > Transverse 
Mercator (� ���. 103). 

������, ���� ���������
 Vertical ����&���
� Set �
� 
�� �
 ����+ �+����� Spheroid 
name > GRS 1980, Datum name > EGSA87 (� ���. 103). 
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���������: ��	��������	� ��������	� 
�
�
���� �?��
� 
����	
� �����
�� (�����	��	�) 
 

CORONA (KH-1,KH-2,KH-3,KH-4,KH-4A,KH-4B)  
%��
���
: CORONA/�
���
����� �
���. 
X'��: 1.�.%. 
6�����
���: NRO/USAF. 
&���)�: 1959-1972. 
$� ������!. 
������ ��������� 
�6��: 185Km KH-4%, 150Km KH-4B & 165-460Km. 
%�
Y��
���  
)+����
: KH-1 KH-2 KH-3 
�������� ���������
�: 

27/6/’59-13/9/’60 
26/10/’60-
23/10/’61 

30/8/’61-
13/1/’62 

$����� 
������ �� m: 13.33  8.33 4-8.33 
��������
 ����6��: ���������&��   
)+����
: KH-4 KH-4A KH-4B 
�������� ���������
�: 

27/2/’62-24/3/’64 
24/8/’63-
22/9/’69 

15/9/’67-
25/5/’72 

$����� 
������ �� m: 3.33-8.33 3-8.33 2-8.33 
��������
 ����6��: ���������&��  
[������!�  
/����� ����� �������: 71.16� (KH-1,KH-2,KH-3,KH-4,KH-4A,KH-4B) 
(����
�� ������ ��� �
���: 15.3x209-42x579 Km (KH-1,KH-2,KH-3),  

17x232 Km KH-4A & 13.8x188 Km KH-4B 
<���� �����
 ���� �����: )�
���� �
��� 
(�
����� �����: )�
���� �
��� 
)������������ ��
�����
: w
�: KH-4,KH-4A,KH-4B 
 

SEASAT 
%��
���
/�����
!� �������: SEASAT/SAR. 
X'��: 1.�.%. 
6�����
���: NASA. 
&���)�: 28 *������ 1978. 
$� �������: 10 /���
���� 1978. 
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�����
�&� 
������� 
 

������ ��������� 
�6��: 800 Km. 
<����:  108o, �����+�#����. 
��������: 102.85 �����. 
%�
Y��
���  
Sensor SAR  
���� L 
!���
 ����������, �: )�
���� 70, ±3 
$����� 
������ �� m 
/����� x 
-���+���: 25 x 25 
)�#�����
 �
�
�������, GHz: 1.275 
"���� �+�
���, cm: 23.5 
�+��� -����, MHz:   19 
������: H/H (���
�
 ������) 
��������
 ����6��: *�
���������� 
J
���������� ��
��������
: 5 bit $
���� 
[������!�  
/����� ����� �������: )�
���� 70, ±3 
(����
�� ������ ��� �
���: 100 Km 
(�
����� �����: 9#� 
 

SIR-A  
%��
���
/�����
!� �������: SIR-A (��
������� ������ Columbia)/SIR-A L-SAR. 
X'��: 1.�.%. 
6�����
���: NASA. 
&���)�: (��&�
���� 1981. 
$� �������: "������ 1982. 
������ ��������� 
�6��: 259 Km. 
<����: ���������&�� �� �����
���� ����� ��������
 
�� 38o. 
%�
Y��
���  
Sensor SIR-A L-SAR  
���� L 
!���
 ����������, �: )�
���� 40, ±3 
$����� 
������ �� m 
/����� x 
-���+���: 40 x 40 
)�#�����
 �
�
�������, GHz: 1.275 




